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How to make a Gantt chart in Excel 2010, 2013 and Excel 2016
by Svetlana Cheusheva Excel, Excel charts, Excel tips 193 Comments

If you were asked to name three key components of Microsoft Excel, what would they be? Most
likely, spreadsheets to input data, formulas to perform calculations and charts to create graphical
representations of various data types.

I believe, every Excel user knows what a chart is and how to create it. However, one graph type
remains opaque to many - the Gantt chart. This short tutorial will explain the key features of the
Gantt diagram, show how to make a simple Gantt chart in Excel, where to download advanced
Gantt chart templates and how to use the online Project Management Gantt Chart creator.

What is the Gantt diagram?

How to make a Gantt chart in Excel

Excel Gantt chart templates

What is a Gantt chart?
The Gantt chart bears a name of Henry Gantt, American mechanical engineer and management
consultant who invented this chart as early as in 1910s. A Gantt diagram in Excel represents
projects or tasks in the form of cascading horizontal bar charts. A Gantt chart illustrates the
breakdown structure of the project by showing the start and �nish dates as well as various
relationships between project activities, and in this way helps you track the tasks against their
scheduled time or prede�ned milestones. 

How to make Gantt chart in Excel 2016, 2013 and
2010
Regrettably, Microsoft Excel does not have a built-in Gantt chart template as an option. However,
you can quickly create a Gantt chart in Excel by using the bar graph functionality and a bit of
formatting.

Please follow the below steps closely and you will make a simple Gantt chart in under 3 minutes.
We will be using Excel 2010 for this Gantt chart example, but you can simulate Gantt diagrams in
Excel 2016 and Excel 2013 exactly in the same way.

1. Create a project table
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You start by entering your project's data in an Excel spreadsheet. List each task is a separate row
and structure your project plan by including the Start date, End date and Duration, i.e. the number
of days required to complete the tasks.

Tip. Only the Start date and Duration columns are really necessary for creating an Excel Gantt
chart. However, if you enter the End Dates too, you can use a simple formula to calculate
Duration, as you can see in the screenshot below. 

2. Make a standard Excel Bar chart based on Start date
You begin making your Gantt chart in Excel by setting up a usual Stacked Bar chart.

Select a range of your Start Dates with the column header, it's B1:B11 in our case. Be sure to
select only the cells with data, and not the entire column.

Switch to the Insert tab > Charts group and click Bar.

Under the 2-D Bar section, click Stacked Bar.
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As a result, you will have the following Stacked bar added to your worksheet: 

Note. Some other Gantt Chart tutorials you can �nd on the web recommend creating an
empty bar chart �rst and then populating it with data as explained in the next step. But I think
the above approach is better because Microsoft Excel will add one data series to the chart
automatically, and in this way save you some time.

Step 3. Add Duration data to the chart
Now you need to add one more series to your Excel Gantt chart-to-be.

Right-click anywhere within the chart area and choose Select Data from the context menu. 

The Select Data Source window will open. As you can see in the screenshot below, Start Date
is already added under Legend Entries (Series). And you need to add Duration there as well.

1.
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Click the Add button to select more data (Duration) you want to plot in the Gantt chart. 2.

The Edit Series window opens and you do the following:

In the Series name �eld, type "Duration" or any other name of your choosing. Alternatively,
you can place the mouse cursor into this �eld and click the column header in your
spreadsheet, the clicked header will be added as the Series name for the Gantt chart.

Click the range selection icon  next to the Series Values �eld.

3.

A small Edit Series window will open. Select your project Duration data by clicking on the �rst
Duration cell (D2 in our case) and dragging the mouse down to the last duration (D11). Make
sure you have not mistakenly included the header or any empty cell. 

4.

Click the Collapse Dialog icon to exit this small window. This will bring you back to the previous
Edit Series window with Series name and Series values �lled in, where you click OK. 

5.

Now you are back at the Select Data Source window with both Start Date and Duration added
under Legend Entries (Series). Simply click OK for the Duration data to be added to your Excel

6.
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Step 4. Add task descriptions to the Gantt chart
Now you need to replace the days on the left side of the chart with the list of tasks.

chart. 

The resulting bar chart should look similar to this: 

Right-click anywhere within the chart plot area (the area with blue and orange bars) and click
Select Data to bring up the Select Data Source window again.

1.

Make sure the Start Date is selected on the left pane and click the Edit button on the right
pane, under Horizontal (Category) Axis Labels. 

2.
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Step 5. Transform the bar graph into the Excel Gantt chart
What you have now is still a stacked bar chart. You have to add the proper formatting to make it
look more like a Gantt chart. Our goal is to remove the blue bars so that only the orange parts
representing the project's tasks will be visible. In technical terms, we won't really delete the blue
bars, but rather make them transparent and therefore invisible.

A small Axis Label window opens and you select your tasks in the same fashion as you selected
Durations in the previous step - click the range selection icon , then click on the �rst task in
your table and drag the mouse down to the last task. Remember, the column header should
not be included. When done, exit the window by clicking on the range selection icon again. 

3.

Click OK twice to close the open windows.4.

Remove the chart labels block by right-clicking it and selecting Delete from the context menu. 

At this point your Gantt chart should have task descriptions on the left side and look
something like this: 

5.

Ultimate Suite for Excel Professionals
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Click on any blue bar in your Gantt chart to select them all, right-click and choose Format
Data Series from the context menu. 

1.

The Format Data Series window will show up and you do the following:

Switch to the Fill tab and select No Fill.

Go to the Border Color tab and select No Line.

Note. You do not need to close the dialog because you will use it again in the next step.

2.

As you have probably noticed, the tasks on your Excel Gantt chart are listed in reverse order.
And now we are going to �x this.

Click on the list of tasks in the left-hand part of your Gantt chart to select them. This will display
the Format Axis dialog for you. Select the Categories in reverse order option under Axis

3.
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Step 6. Improve the design of your Excel Gantt chart
Though your Excel Gantt chart is beginning to take shape, you can add a few more �nishing
touches to make it really stylish.

Options and then click the Close button to save all the changes. 

The results of the changes you have just made are:

Your tasks are arranged in a proper order on a Gantt chart.

Date markers are moved from the bottom to the top of the graph.

Your Excel chart is starting to look like a normal Gantt chart, isn't it? For example, my Gantt
diagram looks like this now: 
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Remove the empty space on the left side of the Gantt chart.

As you remember, originally the starting date blue bars resided at the start of your Excel Gantt
diagram. Now you can remove that blank white space to bring your tasks a little closer to the
left vertical axis.

Right-click on the �rst Start Date in your data table, select Format Cells > General. Write
down the number that you see - this is a numeric representation of the date, in my case
41730. As you probably know, Excel stores dates as numbers based on the number of days
since 1-Jan-1900. Click Cancel because you don't actually want to make any changes here. 

Click on any date above the task bars in your Gantt chart. One click will select all the dates,
you right click them and choose Format Axis from the context menu. 

Under Axis Options, change Minimum to Fixed and type the number you recorded in the
previous step.

1.

Adjust the number of dates on your Gantt chart.

In the same Format Axis window that you used in the previous step, change Major unit and
Minor unit to Fixed too, and then add the numbers you want for the date intervals. Typically,
the shorter your project's timeframe is, the smaller numbers you use. For example, if you want
to show every other date, enter 2 in the Major unit. You can see my settings in the screenshot
below.

2.
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Note. In Excel 2013 and Excel 2016, there are no Auto and Fixed radio buttons, so you simply
type the number in the box.

Tip. You can play with di�erent settings until you get the result that works best for you.
Don't be afraid to do something wrong because you can always revert to the default
settings by switching back to Auto in Excel 2010 and 2007, or click Reset in Excel 2013 and
2016.

Remove excess white space between the bars.

Compacting the task bars will make your Gantt graph look even better.

Click any of the orange bars to get them all selected, right click and select Format Data
Series.

In the Format Data Series dialog, set Separated to 100% and Gap Width to 0% (or close to
0%).

3.
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And here is the result of our e�orts - a simple but nice-looking Excel Gantt chart: 

Remember, though your Excel chart simulates a Gantt diagram very closely, it still keeps the
main features of a standard Excel chart:

Your Excel Gantt chart will resize when you add or remove tasks.

You can change a Start date or Duration, the chart will re�ect the changes and adjust
automatically.

You can save your Excel Gantt chart as an image or convert to HTML and publish online.

Tips:

You can design your Excel Gant chart in di�erent ways by changing the �ll color, border
color, shadow and even applying the 3-D format. All these options are available in the
Format Data Series window (right-click the bars in the chart area and select Format Data

https://www.ablebits.com/office-addins-blog/2013/08/27/save-excel-chart-as-image/
https://www.ablebits.com/office-addins-blog/2014/03/21/convert-excel-html/
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Download this Gantt chart example.

Excel Gantt chart templates
As you see, it's not a big problem to build a simple Gantt chart in Excel. But what if you want a
more sophisticated Gantt diagram with percent-complete shading for each task and a vertical
Milestone or Checkpoint line? Of course, if you are one of those rare and mysterious creatures
whom we respectively call "Excel gurus", you can try to make such a graph on your own, with the
help of this article: Advanced Gantt Charts in Microsoft Excel.

However, a faster and more stress-free way would be using an Excel Gantt chart template. Below
you will �nd a quick overview of several project management Gantt chart templates for di�erent
versions of Microsoft Excel.

Gantt chart template for Excel 2013 and 2016 from Microsoft
This Excel Gantt chart template, called Gantt Project Planner, is purposed to track your project
by di�erent activities such as Plan Start and Actual Start, Plan Duration and Actual Duration as well
as Percent Complete.

In Excel 2013 and 2016, this template is available directly on the File > New tab. If you cannot �nd it
there, you can download it from Microsoft's web-site - Gantt Project Planner template. This

Series from the context menu). 

When you have created an awesome design, it might be a good idea to save your Excel Gantt
chart as a template for future use. To do this, click the chart, switch to the Design tab on the
ribbon and click Save as Template.

https://www.ablebits.com/excel-tutorials-examples/gannt-chart.xlsx
http://peltiertech.com/Excel/Charts/GanttChart.html
http://office.microsoft.com/en-us/templates/gantt-project-planner-TC102887601.aspx
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template requires no learning curve at all, simply click on it and it's ready for use. 

Online Gantt chart template
This is an Interactive Online Gantt Chart Creator from smartsheet.com. As well as the previous Gantt
chart template, this one is fast and easy-to-use. They o�er 30 days free trial, so you can sign with
your Google account here and start making your �rst Excel Gantt diagram online straight away.

The process is very straightforward, you enter your project details in the left-hand table, and as
you type a Gantt Chart is being built in the right-hand part of the screen. 

Gantt chart template for Excel, Google Sheets and OpenO�ce
Calc
Gantt chart template from vertex42.com is a free Gantt chart template that works with Excel 2003,
2007, 2010, 2013 and 2016 as well as OpenO�ce Calc and Google Sheets. You work with this
template in the same fashion as you do with any normal Excel spreadsheet. Simply enter the start
date and duration for each task and de�ne % in the Complete column. To change the range of

https://www.smartsheet.com/s/online-gantt-chart
http://www.vertex42.com/ExcelTemplates/excel-gantt-chart.html
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dates displayed in the Gantt chart area, slide the scroll bar. 

And �nally, one more Gant chart Excel template for your consideration.

Project Manager Gantt Chart template
Project Manager Gantt Chart from professionalexcel.com is also a free project management Gantt
chart template for Excel that can help track your tasks against their allocated time. You can
choose either the standard weekly view or daily for short term projects.

Hopefully, at least one of the above-mentioned Gantt chart Excel templates is well suited for your
needs. If not, you can �nd plenty more Gantt chart templates on the web.

Now that you are familiar with the main features of the Gantt diagram, you can explore it further
and create your own sophisticated Gantt charts in Excel to amaze your boss and co-workers : )

 Nav says:
December 15, 2016 at 10:34 am

Hi there,

My current gantt is entered in days. How can I change that to re�ect weeks? 
Please respond urgently

Thank you

Reply

 unknown says:
November 14, 2017 at 8:00 am

try exiting in weeks. so it will re�ect the weeks that you have wasted.

Reply

1

 Deanne Bhamgara says:
December 23, 2016 at 4:31 pm

Hi there, 
I have a couple inquires for making a timeline on Microsoft Excel. 
If a project has multiple task that occur at the same time, how should I re�ect it on the gantt
chart? I know its quite easy for me to do it on a smartsheet but how would I do it on excel.

Second question, If I do create the chart on Smart sheet, is there a way I can export it to an
excel sheet format?

Reply
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